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Thank you for choosing to use System 180's 3D planning software package.

This 3D planning software package puts the following functions at your fingertips:

∙ Planning and viewing furniture for construction using System 180's furniture assembly system.

∙ Managing your customer data and drawing up offers and orders 

  directly based on the configuration software

∙ Exporting pieces of furniture planned on the system into DXF files to be able to display them 

  on other 3D planning programs, such as pCon.Planner.

In this manual e have summarised the most important functions and steps to follow when 

operating this planning software package. However, this manual is not designed as a substitute 

for proper training in its use. You can find the basic technical information and assembly rules for 

System 180's furniture assembly system in the current issue of our "Facts & Details" booklet.

To get hands-on experience of the capabilities of the planning software package and for practi-

cal tips on how to use it, please make an appointment with our field sales staff. You can find 

further information on training on the last page of this manual.

Yours sincerely, the System 180 team

Welcome!
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Installation
In the "Sales partner services" section of our website, select the 
download that matches your operating system and run it on your machine:

∙ for Mac OS: https://www.system180.com/download/System180_8.1.3.dmg

∙ for Windows: https://www.system180.com/download/System180_8.1.3.msi.zip

After the download has been completed, double click to start the installation.

The setup wizard guides you through the installation step by step

Please note: To install the 3D planning software, you need administrator 
rights on your computer!
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Settings
You will have to make the following settings at minimum if you want to view the 
prices for your plans or to draw up offers and orders:

∙ Enter a valid dealer code* using the "System 180/Settings" menu. 
  Your dealer code will have a range of pre-settings associated with it.

∙ Confi rm your entries by clicking "OK"

Settings

*You will receive your own personal dealer code from our fi eld sales staff.

Your dealer code*
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Contact
When you are fi nished your work, check the pre-set business and delivery ad-
dress in "Settings/Contact". You will be sent an order confi rmation by e-mail to 
the address you entered in the lower left-hand fi eld. 
Confi rm your changes by clicking "OK".

Ordering
Check the VAT rate applicable in your country in the "Settings/Orders“ menu, the 
currency you want to use for your transaction and, where applicable, the applicable 
exchange rate for Euros.

∙ Under the item marked "Retail surcharge“ the costs for delivery and 
  assembly for within mainland Germany of the planned piece are calculated. 
  This amount is currently set at 10%. It makes sense to use this setting if you do not 
want to itemize delivery and assembly costs separately.

Settings

Your email
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Program controls

1

2 3

4

   The program's menu bar: 
∙ Make your program settings using the "System 180" menu
∙ Access functions and information using the "Repository" menu
∙ Switch to "Professional mode" using the "Edit" menu
∙ Use "Camera" to choose the viewing options you prefer and 

how you want element names to be displayed
∙ You can fi nd any current updates in the "Help" menu

   The package's "Toolbox" contains all the tools availab-
le in the system:
∙ Finish (brushed or powder-coated black)
∙ Function
∙ System measurements
∙ Accessories
∙ Décor

   The possible planning options:
∙ New plan
∙ Open plan
∙ Recent plans

   The platform:
∙ For your plan
∙ General changes

2

3

4

1



Manual 3D planning software | Status as of 06/2017 | © System 180 GmbHPage 7 of 20 

The Toolbox contains the following context-sensitive menus: 

Finish shows you fi nishes you have to choose from for the furniture's stainless steel 
components
∙ brushed
∙ powder-coated in black

Function shows you the modules available for you to plan
∙ Linear module
∙ Corner module
∙ Raised module
∙ Work surfaces
∙ Offi ce container
∙ Change system dimensions
∙ Currently selected fi elds are shown surrounded by a frame.
∙ Use the blue arrows to select additional options.

System dimensions shows
∙ all the size options available for the currently selected module

Accessories shows
∙ Accessories for individual selected modules
∙ If you click on the work platform, it switches to show global options for the entire piece 
  of furniture

Décors shows the various available surface fi nishes
∙ If you select individual components, you can change surface fi nishes for each of them 
separately 

∙ Clicking on the work platform allows you to change the surface fi nish globally for the 
entire piece

Order Shows the most important information on the piece of furniture you have planned. 
The fi gures given for dimensions refer to the external dimensions of the piece as a whole.

By clicking on the pale grey bar at the 
top of the Toolbox, you can move it 
around the platform. 
You can expand and collapse the toolbox 
by clicking on the point in its top left-
hand corner.

Each individual menu can also be ex-
panded or collapsed by clicking on the 
menu's heading text. 

The toolbox
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Creating a new plan
Use the "File" menu in order to begin preparing a new plan.

Opening an existing plan
Use the "File" menu in order to open an existing plan.

Drawing up a plan

1

1

2

2
3

3

3

!

To help you correct any mistakes in your planning work, the program's Edit 
menu provides you with the following options:

     Undo: Moves you step-by-step back through your planning process

     Redo: Reverses step-by-step the effect of the Undo function

     Professional mode: If you enable professional mode, you will see two further 
functions in the toolbox:
∙ Select the left-hand symbol to delete entire modules
∙ Select the right-hand symbol to delete individual components

     Please note: We cannot give any guarantees on plans developed in profes-
sional mode. Once a piece of furniture has been edited in professional mode, 
professional mode can no longer be disabled for that piece!
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22

Adding a module
The system for confi guring the furniture assembly system is set out using a mo-
dular structure. You can extend your plans at any time by adding new modules 
through the package, fi tting out each individual module independently of other 
modules in the piece.

     You can create a module of the required dimensions on the work platform by 
selecting a the piece of furniture you require using the Function menu and then cli-
cking on the work platform.

     To add on a further module, move your mouse cursor to the area where you 
want to build it. The preview pane shows you the module that is about to be 
added. When you click on it, the program creates a module using the settings you 
have selected. 

     A piece of furniture can only be extended starting from a visible exterior 
surface. 
For this reason, you may need to rotate the furniture so that the outer surface onto 
which you want to attach the new piece is visible. 

To rotate the piece , click on an empty part of the work platform. 
Press and hold down the mouse button and move the piece to the desired posi-
tion. As an alternative, you can use the "Camera" menu to select from among the 
range of available views. 

You can use the mouse's scroll function to zoom into and out of your plan 
view.

If any menu fails to open, check that you have enabled the correct function in the 
Toolbox (for example, using "Function + Optional" to append new modules or to 
change to another system measurement).

1

1

2

2

3

3
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     To fi t out individual modules separately, select this function by clicking on it. 
The currently selected module is indicated by two red arrows, and the appropriate 
menu appears in the toolbox to allow you to fi t out the selected module. The list 
includes only the accessories that are available for the currently selected modules.

     Fittings that are already present on the module are indicated by a marking on the 
left-hand side of the relevant element.

Any fi ttings that are hidden from view – by doors, for example – will become visible 
via the "mouse-over" function.

Upgrading modules
1

1

2

2

We recommend enabling the "Element 
labelling" function in the "Camera" menu. 
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You can fi t out your piece from two sides. The software treats the side of the 
piece that is facing the user as the front of the piece and the side that is facing 
away from the user as the back.
 
You have a large selection of components available to you for use on the front side. 
For the rear side you will only be able to add "back panels". 
You have a large selection of components available to you for use on the front side. 

Front

Rear

Upgrading modules

180°
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To insert in a cabinet door into the piece your are planning, fi rst select the lower 
of the two modules that you want to close up using the cabinet door. Then choose 
the "Cabinet doors" option in the toolbox in the "Accessories" list. The program then 
inserts the cabinet doors. The shelf that is now surplus to requirements automatically 
disappears, as does the standard bar.

Please note: For structural reasons it is not recommended to fi t free-standing modu-
les with cabinet doors on both sides.

Upgrading modules
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You have a variety of options available to you for integrating work surfaces into your 
furniture plans. 

     To fi t a work surface onto a shelf, fi rst select "Function: Work surfaces" in the 
toolbox. A menu opens showing you the possible dimensions of a work top for your 
piece. Move your mouse cursor to the position where you want to add the work 
top. Position the work top by clicking on that position.

     To change the size of the work top, select "Function: System size" from the 
toolbox and select from the options that the program then lists for you. The modu-
le onto which you are adding the work top is adjusted to suit the size of the work 
surface.

     If you prefer, you can also add the work surface onto a suitable module using 
"Function: Offi ce container".

Adding work surfaces

1

1

2

2

3

3
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     You can use a combination of "Function: Offi ce container“, "Function: Work surfa-
ces" and "Function: Change system dimensions" to design your own customised 
work desk.

     The offi ce container is fi tted out with 4 standard drawers and a lockable pull-out 
drawer for materials. If you would like to include a hanging-folder fi ler in your con-
tainer, then simply select such a container by clicking on it. Die Toolbox then gives 
you a list of the available "Offi ce container variants".

Planning work desks
1

2

1 2
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In some cases you might want to be able to open the Offi ce container from 
more than one side.

     To achieve this, fi rst rotate the work desk or container around.

     Select the container that you want to modify. 

     Select the layout of the container under the "Offi ce container variants" heading

180°

Planning work desks

1

2

3

2 3

1
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     In order to make changes to individual modules, enable the "Function" you 
want for the module from the Toolbox and then click on the module that you want to 
modify. Select the "Accessories" you would like to use from the list. 
Only those fi ttings that are available for the selected module's dimensions will appe-
ar on the list. Accessories that have already been inserted into the plan are indicated 
by means of a marking to the left of them on the list. You can delete accessories 
individually by clicking on that marking. You can delete all accessories included in 
the current module by clicking "Delete accessories".

     To modify accessories globally, click on the white area of the work platform. 
Select the option you required from the "Accessories" list. You might, for example, 
want to replace all side panels with diagonal steel tubing wherever such panels no 
longer make sense due to presence of accessories. To do this, click on "Replace 
existing elements".

     To change the dimensions of a module, select "Function: Change system 
dimensions" in the toolbox and click on the module whose dimensions you want 
to change. You can now make your changes to its dimensions using the "System 
dimensions“ selection list in the toolbox.

Please note: All contiguous modules will also have their dimensions altered approp-
riately by the system!

     To change the décor for a piece of furniture , you have two options:
- Change the décor for the entire piece by clicking on the white area of the platform. 
Enable the"Décor" menu in the toolbox and click on the décor type you require.
- To highlight individual components in colour, fi rst click on the white area of the 
work platform. Select the "Décor" menu in the toolbox. Then click on the compo-
nent you want to edit. Then select the décor that you want to use for that compo-
nent.

Modifying plans

1 1

2

2

3

3

4 4
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You can read all the components necessary for your arrangement along 
with their individual prices in the "Repository/Components list" menu item in the 
program menu.

Components list and prices
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You can save your plans using the program menu by selecting "Repository":

Save / Save as
Select the location where you want to save your plan and enter a name for it.

Save as sample
The plan is saved as a templates and can be accessed again later using "Open 
plan…".

Export
The plan is output as a DXF fi le.

Saving your plans
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To draw up your offers and orders select "Repository/Make an order" from the 
main menu bar

Select the promotion you want to use from the options "Offer" and "Order confi rma-
tion" for your customer or "System 180 order".

If the customer to whom you want to sent an offer or order confi rmation already 
exists in the system, then you can select that customer directly from the system.

Use "+" "-" and "i" to create, delete or edit customers.

When you click on "OK", the program will create a PDF fi le containing all the data you 
have selected.

Preparing orders and offers
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Do you need some training or additional help on how to use of the configurator software?
Please contact our field sales staff:

Arne Stamer
stamer@system180.com

Help

System 180 GmbH

Ernst-Augustin-Str. 3

12489 Berlin

+49 30 788 58 41

contact@system180.com

www.system180.com


